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1 ABOUT THESE INSTRUCTIONS 

These instructions apply to 963 version 3.73 [SP2] software. They provide information about installing, upgrading, 

and licensing the 963. 

The 963 uses Open Source Software provided by Third Parties. For more information, refer to '963-open-source-

license.txt' which is available on the DVD as well as in the install directory. 

1.1 Conventions Used in this Manual 

There are numerous items and instructions in this manual, the conventions below are designed to make it quick and 

easy to find and understand the information. 

 Menu commands are in bold type. 

 Buttons and options in dialogue box that you need to select are in bold type. 

 The names of text boxes and dialogue boxes are in bold type. 

 Key combinations that you should press appear in normal type. If joined with a plus sign (+), press and hold 

the first key while you press the remaining one(s). For example CTRL+P indicates holding down the control 

key while pressing P. 

 Text you should enter is in Italic type. 

 For the Touch screen UI, the touch functionality is as explained in the following table: 

To... Do This... 

Open the Start screen Windows key. 

Return to the Start screen Lower-left corner and then tap the miniature Start screen that appears. 

Left click Tap the option. 

Right-click Press and hold. When a box appears, lift your finger. The right-click 

menu appears. 

Enter values via onscreen key-

board 

Tap the Touch Keyboard button on the taskbar. 

Close the Touch keyboard Tap the X button on the Touch keyboard. 

Move Tap the option and slide it. 

Resize Tap the option, then press and drag the object’s resize handle. 

Hover over an item Press and Hold. 

1.2 Contacting Trend 

Head Office 

Trend Control Systems Ltd 

St. Marks Court 

North Street 

Horsham 

West Sussex 

RH12 1BW 

UK 

Tel: +44 (0) 1403 211888 

 

Details of regional offices can be found on our web site. 

Internet 

Our company web site (www.trendcontrols.com) provides information about our products and us. Accredited partners 

should contact our support web site (https://partners.trendcontrols.com). 

Technical Support 

Our support department provides technical support during normal office hours. Before contacting them ensure that 

you have your Technical Support PIN number available, without this we will be unable to provide you with any 

support. 

Tel: +44 (0) 1403 226600 

Email: trendts@trendcontrols.com 

Fax: +44 (0) 1403 226310 

Technical Publications 

Please send any comments on this or any other Trend technical publication to techpubs@trendcontrols.com. 

mailto:techpubs@trendcontrols.com
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2 INSTALLATION 

This section describes how 963 should be installed to ensure that it operates correctly. 963 can be run free of charge, for a 28-

day trial period but after this a licence must be purchased in order to continue using 963. Before installing 963 or upgrading to 

963 v3.73 [SP2], you should ensure that the PC meets the system requirements see the 963 Data Sheet (TA200636). 

If the 963 is to communicate with devices on a BACnet network TOPS must also be installed as described in the TOPS 

Installation Instructions (TG201036). This installation can be on the same PC as 963, or on a different PC providing 

communication is possible between the two over Ethernet. 

Note: Installation of 963 requires an internet connection. 

963 Clients 

Popup blocking software must be disabled, or configured to allow popups from the 963 Server. 

PC Resources 

963 is a real time application; installed PCs must have enough free resources to safely run 963 under peak load 

conditions. We cannot guarantee system performance if other 3rd party software is installed, for example virus 

checking software. 

File Attributes, compression and encryption 

Windows compression or encryption must not be used for the 963's SQL database, or any other 963 file in the project 

directory also ensure that all files in the project directory have full write access and are not offline. 

After the installation is complete it is strongly recommended that the details in the Engineering manual and Best 

practice security guideline are adhered to.  

2.1 Installation Procedures 

The process for installing the 963 differs slightly depending on your requirements, and system configuration, you 

should follow the one that matches your needs. 

 Standard Installation - This section describes the standard 963 installation procedure, it should be suitable 
for most installations and should be followed unless your installation is one of the non standard ones 
described below. 

 Installation for use with full version of SQL Server - This section describes the installation procedure if the 
963 is to connect to a full version of SQL Server on the same PC as 963. 

 Installation for use with a Remote SQL Server - This section describes the installation procedure required if 
the 963 is to access a remote SQL Server. 

 Installation on an Unsupported Language Version of Windows® - This section describes the installation 

procedure required if the 963 is to be installed on a PC running a Windows® language other than English 

(UK), English (USA), Arabic, Simplified Chinese, Traditional Chinese, Danish, German, Spanish, Finnish, 

French, Italian, Dutch, Polish, Russian, Hebrew, Norwegian, Swedish. 

2.1.1 Standard Installation  

This section describes the standard installation procedure for installing the 963. This procedure should be suitable for 
most installations. When installed as described below 963 will use SQL Server 2012 Express Edition with Tools 
installed on the same PC as 963, and will access SQL server in Windows Authentication mode.  

Standard installation: 

1. Ensure that the PC meets the system requirements - see the 963 Data Sheet (TA200636). 

2. If required connect the PC to the Ethernet Network. 

Ensure that you have installed all the Microsoft updates before installing 963. 

3. Install the 963 software. 

4. Log in to Windows as an 'Admin' user, run 963 and licence it. 

When the 963 is run for the first time, it displays a password for the System Administrator. This password 

MUST be noted, as without this password it will not be possible to access to the 963. 

5. Connect the GSM modem. (963 SMS Direct only). 

6. Configure the GSM connection (963 SMS Direct only). 

7. Connect the PC to the IQ network. 

8. Check communications. 

9. If users not belonging to the Windows® 'Administrator' workgroup are to run 963 ensure that they have 

access to SQL server. 

After the installation is complete it is strongly recommended that the 963 be configured to automatically archive 

the database as described in the 'Configure Automatic Archiving' section of the 963 Engineering Manual 

(TE200637) and ensure that the DELETEHISTORIC DATA command is executed to prevent the database 

from becoming too large. 
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2.1.2 Installation for use with Full Version of SQL Server  

This section describes how 963 should be installed for use with a full version of SQL Server that is installed on the 

same PC as 963. 

Note: To carry out this procedure a full version of SQL Server which must be purchased separately, and is not 

available from Trend. 

To install 963 for use with a full version of SQL Server: 

1. Ensure that the PC meets the system requirements - see the 963 Data Sheet (TA200636). 

2. If required connect the PC to the Ethernet Network. 

3. Install a full version of SQL Server following the manufacturer's instructions. 

4. Configure SQL Server. 

5. Install the 963 software. 

6. Log in to Windows as an 'Admin' user, run 963 and licence it. 

7. Connect the GSM modem. (963 SMS Direct only). 

8. Configure the GSM connection (963 SMS Direct only). 

9. Check communications. 

10. If users not belonging to the Windows® 'Administrator' workgroup are to run 963 ensure that they have 

access to SQL server. 

After the installation is complete it is strongly recommended that the 963 be configured to automatically archive 

the database as described in the 'Configure Automatic Archiving' section of the 963 Engineering Manual 

(TE200637) and ensure that the DELETEHISTORIC DATA command is executed to prevent the database 

from becoming too large. 

2.1.3 Installation for use with a Remote SQL Server  

This section describes how 963 should be installed for use with a remote SQL Server. 

963 supports the following versions of SQL Server: 

 SQL Server 2012 0r 2017 

To install 963 for use with a remote SQL Server: 

1. Ensure that the PC meets the system requirements - see the 963 Data Sheet (TA200636). 

2. Connect the PC to the Ethernet Network. 

3. Install the 963 software on the appropriate PC (PC 1). 

4. Install the required version of SQL Server on the appropriate PC (PC 2) following the manufacturer's 

instructions 

5. Configure the SQL Server. 

6. Ensure that the PC running 963 (PC 1) and the PC running SQL Server (PC 2) are set up on the same network 

or domain. 

7. Create a directory on PC 2 that is the same as directory 963 is installed in on PC 1 (normally c:\program files 

(x86)\trend control systems\963) on PC 2. 

8. Log in to Windows as an 'Administrator' user, run 963 and licence it. 

When the 963 is run for the first time, it displays a password for the System Administrator. This password 

MUST be noted, as without this password it will not be possible to access to the 963. 

9. Configure the 963 to Connect to a Remote SQL Server. 

10. Restart 963. The 963 will create an empty database on the remote SQL Server PC (PC 2). 

11. Connect the GSM modem. (963 SMS Direct only). 

12. Configure the GSM connection (963 SMS Direct only). 

13. Connect the PC to the IQ network. 

14. Check communications. 

15. If users not belonging to the Windows® 'Administrator' workgroup are to run 963 ensure that they have 

access to SQL server. 

After the installation is complete it is strongly recommended that the 963 be configured to automatically archive 

the database as described in the 'Configure Automatic Archiving' section of the 963 Engineering Manual 

(TE200637) and ensure that the DELETEHISTORIC DATA command is executed to prevent the database 

from becoming too large. 
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2.1.4 Installation on an Unsupported Language Version of Windows  

This section describes how 963 should be installed on a PC running a Windows language other than English (UK), 

English (USA), Arabic, Simplified Chinese, Traditional Chinese, Danish, German, Spanish, Finnish, French, Italian, 

Dutch, Polish, Russian, Hebrew, Norwegian, Swedish. 

To install 963 on an unsupported language version of Windows®: 

1. Ensure that the PC meets the system requirements - see the 963 Data Sheet (TA200636). 

2. If required connect the PC to the Ethernet following the manufacturer's instructions. 

4. Configure SQL Server. 

5. Install the 963 software. 

6. Log in to Windows as an 'Administrator' user, run 963 and licence it. 

7. Connect the GSM modem. (963 SMS Direct only). 

8. Configure the GSM connection (963 SMS Direct only). 

9. Connect the PC to the IQ network. 

10. Check communications. 

11. If users not belonging to the Windows® 'Administrator' workgroup are to run 963 ensure that they have 

access to SQL server. 

After the installation is complete it is strongly recommended that the 963 be configured to automatically archive 

the database as described in the 'Configure Automatic Archiving' section of the 963 Engineering Manual 

(TE200637) and ensure that the DELETEHISTORIC DATA command is executed to prevent the database 

from becoming too large. 

2.2 Connect the PC to the Ethernet Network 

If the 963 is to connect to the IQ network over Ethernet, is act as a server providing BMS information to clients, or if 

access to company IT information such as the company Intranet, or the Internet is required, the PC must be connected 

to an Ethernet network. Connection in this way does not prevent connection to the IQ network over the Ethernet. 

To connect the PC to the Ethernet network: 

1. If necessary fit a suitable Ethernet adaptor to the PC, following the manufacturer’s instructions. 

2. If connection is to be made using a wireless network necessary configure the device to connect to the wireless 

network, otherwise plug the Ethernet network cabling into the Ethernet adaptor. 

3. Configure Windows Networking to suit the Ethernet network. 

4. Configure any other necessary parameters required for the office network. 

Note that assistance from the IT department responsible for the Ethernet network will normally be required. 

2.3 Install the 963 Software  

The installation of the 963 software is performed by a step-by-step installation program. During the installation 

procedure you will be required to enter the serial number for the software. This is located on the back of the case; you 

should keep this number in a safe place because it will be required when you purchase a licence. 

During installation 963 will install any required software that is not already installed on the PC. If SQL server is not 

installed on the PC with the MSSQLSERVER instance 963 will install SQL Server 2012 Express Edition with Tools. 

To install the software: 

1. Log in to the PC as someone with Administrator rights. 

2. Insert the DVD into the disk drive, and wait for the installation screen to appear. 

Note that if autorun is disabled run SETUP.exe from the DVD. 

3. Follow the instructions on the screen. 
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2.4 SQL Server Installation and Configuration 

The information contained in this section is only required if a non standard installation of 963 or SQL Server is 

required or if an error occurs during a standard 963 installation which means that the 963 installation programme is 

unable to install SQL Server 2012 R2 Express Edition with Tools. It contains information about installing SQL Server 

2012 R2 Express Edition with Tools, and configuring SQL Server 2012 R2 Express Edition with Tools. It also 

describes installation and configuration of a full version of SQL Server 2012 R2. 

2.4.1 SQL Server 2012 R2 Express Edition with Tools 

2.4.1.1 Install SQL Server 2012 R2 Express Edition with Tools 

To install SQL Server 2012 R2 Express Edition with Tools: 

1. Log on to the PC as someone with Administrator rights.  

2. Install Windows Installer v4.5 as described in the `Install Windows Installer v4.5` section of this manual. 

Not required for Windows 7, Windows 8 and Windows Server 2012.  

3. Install .NET 3.5 Service Pack 1 as described in the `Install .NET 3.5 Service Pack 1` section of this manual.  

4. Install Power Shell 2.0 as described in the `Install Power Shell 2.0` section of this manual. Not required for 

Windows 8 and Windows Server 2012. 

5. Run the SQL Server 2012 R2 Express Edition with Tools installation.  

 

32 Bit Operating Systems: 

 Run ‘SQLEXPRWT_x86_ENU.exe’ from the 'Support Files\Microsoft SQL Server 2012 R2 Express 

Edition \32-bit' directory of the 963 installation DVD.  

64 Bit Operating Systems: 

 Run ‘SQLEXPRWT_x64_ENU.exe’ from the 'Support Files\Microsoft SQL Server 2012 R2 Express 

Edition \64-bit' directory of the 963 installation DVD. 

 

The SQL Server Installation Center screen is displayed. 

 

 
 

6. Click New installation or add features to an existing installation. The installation checks that the pre-

requisites are met. While this is being carried out a number of dialogue progress displays appear. If this is 

the case the License Terms screen is displayed. If not a dialogue box is displayed indicating the issue. 

These must be corrected before the installation can continue. 
7. Select the I accept the License terms check box. Only do this once you have read the terms and are 

agreeable.  

8. Click Next>. The Setup Support Rules screen is displayed and the process is carried out.  
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When it is complete the Installation Type screen is displayed. Continue with the default settings for the Installation 

Type screen. 

 

9. Click Next>. The License Terms page is displayed.  



Installation 

963 Installation Instructions TG201026 Issue 15, 29-Jan-2019 12 

 
 

10. Select the ‘I accept the license terms’ checkbox after you have read and agreed with the terms.  

11. Click Next>. The Feature Selection screen is displayed. 
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12. Click Select All. 

13. Click Next>. The Instance Configuration screen is displayed. 

 

 
 

14. Select the Named instance option and in the Named instance box enter MSSQLSERVER.  

15. Click Next>. The installation checks the space requirement. If there is sufficient space the Server 

Configuration screen is displayed.  
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16. Under the Service Accounts tab, in the Account Name column of the SQL Server Database Engine row 

select NT AUTHORITY\SYSTEM.  

17. Click the Collation tab.  

 

 
 

18. Ensure that ‘SQL_Latin1_General_CP1_CI_AS’ is selected. If this is not the case click Customize and 

select Latin1_General from the Collation designator box in the displayed dialogue box.  
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19. Click Next>. The Database Engine Configuration screen is displayed.  

 

 
 

20. Select the Mixed Mode (SQL Server authentication and Windows Authentication) option.  

21. In the Enter password box enter saTrend06.  

22. In the Confirm password box enter saTrend06.  

23. Click Next>. The Error reporting screen is displayed.  
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24. Click Next>. The installation process starts and the Installation Progress screen is displayed. When the 

installation is complete the following screen is displayed. 

  

 
 

25. Click Close.  

26. Click  to close the SQL Server Installation screen.  

27. Restart the PC.  

28. Configure SQL Server 2012 R2 Express Edition with Tools as described in the 'Configure SQL Server 

2012 R2 Express Edition with Tools' section of these instructions. 

 

2.4.1.2 Install Windows Installer v4.5 (not applicable for Windows 7, Windows 8 and Windows Server 

2012) 

In order to install SQL Server 2012 R2 Express Edition with Tools Windows Installer v4.5 must be installed on the 

PC. 

To install Windows Installer v4.5: 

1. Backup the PC. 

2. Close all programs. 

3. Log on the PC as someone with Administrator rights. 

4. Copy the appropriate installation file for the operating system that is being used onto the PC see the table 

     below. These file are located in the ‘Support Files\Windows Installer 4.5’ folder of the 963 installation DVD. 

Operating System File to Use 
Windows XP Service pack 3 32-bit WindowsXP-KB942288-v3-x86.exe 

Windows Server 2003 Service pack 2 64-bit WindowsServer2003-KB942288-v4-x64.exe 

Windows Server 2003 Service pack 2 32-bit WindowsServer2003-KB942288-v4-x86.exe 

Windows Vista Service pack 2 32-bit  Windows6.0-KB942288-v2-x86.msu  

Windows Server 2012 Enterprise 32 bit  Windows6.0-KB942288-v2-x86.msu  

Windows Server 2012 Standard 32 bit  Windows6.0-KB942288-v2-x86.msu  
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5. Run the file. The Software Update Installation Wizard is displayed.  

 

 
 

6. Click Next>. The wizard changes.  

 

 
 

7. Select the I Agree option. Only do this once you have read the terms and are agreeable.  

8. Click Next>. The wizard changes and the installation starts.  
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9. When the installation is complete the wizard changes to indicate this.  

 

 
 

10. Click Finish.  

11. Restart the PC.  

 

2.4.1.3 Install .NET 3.5 Service Pack 1 

In order to install SQL Server 2012 R2 .NET 3.5 Service Pack 1 must be installed on the PC.  

To install .NET 3.5 service pack 1:  
1. Backup the PC.  

2. Close all programs.  

3. Log on the PC as someone with Administrator rights.  

4. Installation is possible using the Windows 8 DVD or the internet.  

 

Using the DVD  
1. Insert the DVD into the disk drive.  

2. Click Start> Run and type:  

DISM /Online /Enable-Feature /FeatureName:NetFx3 /All /LimitAccess 

/Source:d:\sources\sxs  
3. Click Enter. A confirmatory message is displayed post the successful installation of .Net 3.5.  

 

Via 963 installer setup  
1. Click 963 installer to run the application.  

2. A dialogue box prompts to Download and install the .NET 3.5 service pack 1 files.  

3. Select this option.  

4. Follow the instructions on the screen. A confirmatory message is displayed after the successful 

installation of .Net 3.5.  

 

Manually  
1. Click Start> Control Panel> Programs and Features.  

2. Click Turn Windows features on or off in the left panel.  

3. Select the .Net Framework 3.5 (includes .Net 2.0 and 3.0) checkbox and click OK. A 

confirmatory message is displayed after the successful installation of .Net 3.5. 
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2.4.1.4 Install Power Shell 2.0 (Not applicable for Windows 7, Windows 8 and Windows Server 2012)  

In order to install SQL Server 2012 R2 Express Edition with Tools Power Shell 2.0 must be installed on the PC.  

To install Power Shell 2.0:  
1. Backup the PC.  

2. Close all programs.  

3. Log on the PC as someone with Administrator rights.  

4. Copy the appropriate installation file for the operating system that is being used onto the PC see 

      the table below. These file are located in the ‘Support Files\Power Shell 2.0’ folder of the 963 

      installation DVD.  

Operating System File to Use 

Windows XP Service pack 3 32-bit  WindowsXP-KB968930-x86-ENG.exe  
Windows Server 2003 Service pack 2 32-bit  WindowsServer2003-KB968930-x86-ENG.exe  
Windows Server 2003 Service pack 2 64-bit  WindowsServer2003-KB968930-x64-ENG.exe  
Windows Vista Service pack 2 32-bit  Windows6.0-KB968930-x86.msu  
Windows Server 2012 Enterprise 32 bit  Windows6.0-KB968930-x86.msu  
Windows Server 2012 Standard 32 bit  Windows6.0-KB968930-x86.msu  

 
5. Run the file. The Software Update Installation Wizard is displayed. 

 

 
 

6. Click Next>. The wizard changes  

 

 
 

7. Select the I Agree option. Only do this once you have read the terms and are agreeable.  

8. Click Next>. The wizard changes and the installation starts.  
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9. When the installation is complete the wizard changes to indicate this.  

 

 
 

10. Click Finish.  

11. Restart the PC.  

 

2.4.1.5 Configure SQL Server 2012 R2 Express Edition with Tools  

If SQL Server 2012 R2 Express Edition with Tools has been installed manually as described in the 'Install SQL 

Server 2012 R2 Express Edition with Tools' section of this manual it must be configured correctly so that 963 can be 

used.  

 

Note that this configuration is performed automatically if SQL Server 2012 R2 Express Edition with Tools is 

installed by the 963's installation program.  

 

To configure SQL Server 2012 R2 Express Edition with Tools:  
1. Ensure that the 963 is not running.  

2. On the Start menu, point to Microsoft SQL Server 2012 R2, then point to Configuration Tools and 

     click SQL Server Configuration Manager. The SQL Server Configuration Manager window is  

     displayed.  
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3. In the left pane click  next to 'SQL Server Network Configuration'.  

4. In the left pane click Protocols for MSSQLSERVER. The screen changes.  

 

 
 

5. Right click Named Pipes and click Enable. A dialogue box is displayed, click OK.  

6. Right click TCP/IP and click Enable. A dialogue box is displayed, click OK.  

7. In the pane click SQL Server Services. The screen changes.  

 

 
 

8. Right click SQL Server (MSSQLSERVER) and click Restart.  

9. Once the restart is complete click .  
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10. On the Start menu, point to Microsoft SQL Server 2012 R2, and click SQL Server Management  

       Studio. The Connect to Server dialogue box is displayed.  

 

 
 

11. Ensure that `Windows Authentication` is selected in the Authentication mode box.  

12. Click Connect. The Microsoft SQL Server Management Studio window is displayed. 
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13. In the left pane, right click top level of the navigation tree and select Facets. The View Facets window is 

displayed.  

 

 
 

14. In the Facet box select Surface Area Configuration. The display changes.  

 

 
 

15. Set `XPCmdShellEnabled` to be `True`.  

16. Click OK.  

17. Click  to close the Microsoft SQL Server Management Studio screen.  
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2.4.2 SQL Server 2012 R2  

2.4.2.1 Install a Full version of SQL Server 2012 R2  

To install a full version of SQL Server 2012 R2: 

1. Install SQL Server according to the instructions supplied by Microsoft®. During the installation you must 

ensure that the following information is configured. 

 Install all features. 

 SQL Server instance. The SQL Server can be installed using any instance, however Trend recommend 

MSSQLSERVER. 

 The built-in System account should be set to 'Local System'. 

 The SQL Browser service must be started at the end of set up. 

 Mixed Mode (Windows Authentication and SQL Server Authentication) must be used with a password 

of 'saTrend06'. 

 The currently logged on user must be added to the SQL Server Administrator role. 

2. For 963 to operate it is necessary to configure a Full Version of SQL Server 2012 R2 as described in  

the 'Configure SQL Server 2012 Express Edition with Tools' section of these instructions. 

Caution: The operation should only be carried out by an SQL specialist. 

 

2.4.2.2 Configure a Full Version of SQL Server 2012 R2 

If a full version of SQL Server has been installed manually as described in the 'Install a Full Version of SQL Server 

2012 R2 section of this manual it must be configured correctly so that 963 can be used. 

To configure a full version of SQL Server 2012 R2: 

1. Ensure that the 963 is not running. 

2. Following the instructions supplied by Microsoft® configure the following: 

 Enable 'Named Pipes'. 

 Enable 'xp_cmdshell'. 

If the SQL server is installed on a remote the following must also be configured. 

 Enable local and remote connections. 

 Enable both TCP/IP and named pipes for local and remote connections. 

 Set the SQL Browser service to start automatically. 

Caution: The operation should only be carried out by an SQL specialist. 

 

2.5 Licence 963 

Before 963 can be used, it must be licenced. The licence will allow you to run 963 on a single PC. If you wish to run 

963 on another PC, another licence must be purchased, or the existing licence transferred to the other PC. 

If 963 is already licenced, and you want to upgrade the licence to allow client/server operation, or more clients, contact 

us and purchase the appropriate upgrade. You will then be provided with a new site key that must be entered before 

the new facilities will be available. 

To licence 963: 

1. Obtain an unlock code. 

2. Enter the unlock code. 

The 963 uses CrypKey to perform the licensing functions. CrypKey may not work after disk defragmentation using 

Speed Disk included in Norton utilities. This problem may exist with other defragmentation programs; see the 

‘Problems with Defragmentation Programs’ section of the 963 Engineering Manual (TE200637). 

The use of virus scanning and anti spyware programs may also cause problems with the licence as they may remove 

one of the CrypKey files, see the ‘Problems with Virus Scanning and Anti Spyware Programs’ section of the 963 

Engineering Manual (TE200637). 
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2.5.1 Obtain an Unlock Code  

To licence 963 it is necessary to obtain an unlock code. 

To obtain an unlock code: 

1. Run 963. 

2. Log in as a system administrator. 

3. Press F1 to display the Information Centre. 

4. Click . The Licence Editor dialogue box is displayed. 

 

5. If it is not displayed in the Serial no box enter the serial number. The serial number can be found on the back 

of the CD case. 

6. Click Licence 963.  The Licence Details dialogue box is displayed. 

 

7. In the Contact Name box enter your name. 

8. In the Company Name box enter your company name. 

9. In the Your Fax No box enter your fax number. 

10. In the Contact Number box enter a telephone number at which you can be contacted. 

11. In the Email box enter your email address. 

12. In the Site Name box enter the site on which 963 is to be installed. 

13. In the Site Address box enter the address of the site. 

14. Click OK. Notepad will now be run with the file 'faxform.txt'. 

15. On the File menu click Print in notepad to print out this file. 

16. Click Close. 

17. Go to https://partners.trendcontrols.com, login required. 

18. Follow the instructions to obtain the unlock code. If you have any problems contact our Customer Services 

Department: Email: trendts@trendcontrols.com  Tel +44 (0)1403 226600. 
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2.5.2 Enter the Unlock Code  

To enter the unlock code: 

1. Obtain an unlock code. 

2. Run 963. If the trial period has expired the Licence Editor dialogue box is displayed. If the trial period has 

not expired log in as someone with a PIN level of 99, press F1 to display the Information Centre, and click 

 to display the Licence Editor dialogue box. 

 

3. In the When you receive your site key, please type it in below box enter the unlock code either by clicking 

Format 1 and copying and pasting it into the box, or clicking Format 2 and typing it into the box. 

4. Click Update, a dialogue box is displayed informing you that the 963 has been licenced. If you want to view 

a text file containing detailed licence information is displayed click Yes, otherwise click No. 

Note that the text file containing detailed licence information is '963LicenceDetail.txt' store in the directory 

the 963 is installed in, and can be viewed in Notepad. 

5. Click Close. 

Note that the procedure described above can also be used to update the licence if it has changed. 

6. Restart the 963. 

If the 963 has been licenced with SMS Direct a dialogue box is displayed allowing the GSM connection to be 

configured click OK to configure the GSM Connection now, or Cancel to leave it until later. For details of configuring 

the connection see the ‘Configure the GSM Connection’ section of these instructions. 
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2.6 Configure 963 to Run Under a Non-Admin User 

For Windows 7, 8 and 10 963 can be run by a user with non admin privileges by configuring the set up as below. 

To configure 963 to run under a non admin user: 

1. Log on to the PC as someone with Administrator rights. 

2. Check that the Crypkey License and the SQL Server (MSSQLSERVER) services have started. 

 Click Start >Run. 

 Type services.msc and click OK. 

 In the Services window verify that the . If either one has not started right click and select Start. 

3. Ensure Named Pipes and TCP/IP SQL Server protocols are enabled using SQL Server Configuration 

Manager tool. 

 Click Start >Microsoft SQL Server 2012> Configuration Tools > SQL Server Configuration 

Manager 
 View the SQL Server Network Configuration options and select Protocols for MSSQLSERVER 

 Verify if the Named Pipes and TCP/IP protocols status are enabled. If either one is not enabled right 

click and select Enable. 

4. Provide users/groups that will launch the 963 full control permissions to 963's install floder. 

 Go to the 963 install folder. (e.g. C:\Program Files\x86\Trend Control Systems). 

 Right-click the 963 folder and select Properties. The 963 Properties dialogue box is displayed. 

 Select the Security tab and click Edit…. The Permissions for 963 dialogue box is displayed. 

 

 Click Add…. The Select Users, Computers, Service Accounts or Groups dialogue box is 

displayed. 

 

 For locations, select 'Local Machine'. 

 In the enter the object names to select box enter the name(s) of the user(s)/group(s) to that require 

access. 

 Click Check Names to verify their validity. 

 Click OK. 

 In the Permissions for 963 dialogue box, select the recently added user/group and select the Allow 

checkbox to provide full control permission. 

 Click OK. 
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5. Provide users/groups that will launch the 963 full control permissions to the 'C:\ProgramData\Crypkey' 

folder. 

 Go to the CrypKey folder. (e.g. C:\ProgramData\CrypKey). 

 Right-click the CrypKey folder and select Properties. The CrypKey Properties dialogue box is 

dislayed. 

 Select the Security tab and click Edit…. The Permissions for CrypKey dialogue box is displayed. 

 

 Select the user/group that needs access to 963 and select the Allow checkbox to provide full control 

permission. 

 Click OK. 

Note: By default the ProgramData is a hidden folder. Ensure that you modify the Folder Options to view the 

hidden files. 

6. Update the [Database] section in S2.INIi ( C:\Program Files\x86\Trend Control Systems\963\s2.ini) to 

include the database machine name and the location where 963 database is located on that machine. E.g: 

[Database] 

Server=local PC name 

Directory=<C:\Program Files\x86\Trend Control Systems\963\database> 

Using SQL studio manually attach the 963 Database to SQL. 

2.7 Configure 963 to Connect to a Remote SQL Server  

If required 963 can connect to a SQL Server on a different device this enables 963's database to be located on a 

network drive. 

To configure 963 to connect to a remote SQL Server: 

1. Run 963 and log in as some with System Administrator rights. 

2. On the Database menu, click Properties. The Database Properties dialogue box is displayed. 

3. In the Current database server box specify the location of the SQL Server. If the default SQL instance has 

been used (MSSQLSERVER) it is only necessary to enter the name of the PC on which SQL Server is 

running. If a different instance name has been used the location of the SQL Server must be specified using 

the PC name and the instance name in the form shown below. 

<SQL Server PC name>\<instance name> 

<SQL Server PC name> specifies the name of the PC on the network on which the SQL Server is installed. 

<instance name> specifies instance name used to install the SQL Server. 

E.g. 963\TREND963SQL 

This specifies a PC called 963 and a SQL instance of TREND963SQL. 

4. Click OK. A dialogue box is displayed reminding you that you need to restart 963. 

5. Click OK. 

6. Close 963. 

7. Run 963. If the database exists 963 will connect to it, if not a dialogue box is displayed informing you that it 

can't connect to the database, click Yes to enable 963 to create a new database. 
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If the 963 is not able to connect to the remote SQL Server, check the following: 

 The ‘i96X’ database user is available in the remote SQL Server operating in SQL Server authentication 

mode with a password of ‘Trend963’. If it is not available create a user called `i96X` user as `sysadmin` 

user in the remote SQL Server making a note of  the password. 

 It is possible to connect to the remote SQL Server using SQL Server Management Studio and the i96X 

user. 

 The files `i96X_data.mdf` and `i96X_log.ldf` are NOT in the 963`s project directory 

Caution the operation should only be carried out by an SQL specialist. 
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2.8 Connect the GSM Modem  

If 963 SMS Direct is being used it is necessary to connect the PC to the supplied GSM modem. The modem should 

be connected to the PC as described in the documentation supplied with the modem. Once the modem is connected to 

the PC the GSM connection must be configured. 

Note that the GSM modem supplied with 963SMS Direct does not contain a SIM card. The SIM card should be 

obtained separately before connecting the GSM modem. 

To connect the GSM modem: 

1. Obtain and install a SIM card 

2. Connect the GSM modem to the PC as described the supplied documentation. 

Do not install the mobile phone tools on the CD supplied in the modem package as they may interfere with the 

operation of 963 SMS. 

2.9 Configure the GSM Connection 

If the 963 has been licensed with SMS direct it is necessary to configure the GSM connection that is to be used. The 

first time 963/…/SMS is run a dialogue box enabling the GSM connection to be configured is displayed. You can 

choose to configure it then, or it can be done later. The GSM connection can either be configured automatically or 

manually. 

When configuring the GSM connection it is recommended that any PIN requirement of the SIM be disabled, the use 

of PINs is NOT recommended. 963 does allow the use of PINs, however if the SIM card is swapped and an incorrect 

PIN number is present within the supervisor the SIM is likely to become locked. This is because 963 attempts to 

unlock the SIM and after three incorrect attempts the SIM will be locked and a PUK number is required. 963 keeps 

track of how many times the PIN is entered and will warn you if it thinks you are about to lock your SIM. The PUK 

is available from whatever mobile phone network you are using and can be unlocked using any standard mobile phone. 

If a pay as you go SIM is being used to send the alarms it is recommended that a scheduled event be set up to send a 

regular SMS message to keep the SIM active. Some pay as you go SIM cards will be deactivated by the provider if 

they are not used for a period of time. 

2.9.1 Configure the GSM Connection Automatically  

963 will scan all the PC’s COM ports looking for a GSM device if one is found it will be used. 

To configure the GSM connection automatically: 

1. Run 963 and log in as someone with authority to configure SMS settings. 

2. If the SMS Management dialogue box is not displayed on the SMS menu click Properties to display it. 

 

3. Click Test device. A dialogue box is displayed asking you to ensure the GSM modem is connected. 

4. Check the GSM modem is correctly connected to the PC and turned on. 
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5. Click OK. The SMS Test dialogue box is displayed and 963 will scan all the COM ports to locate the GSM 

modem. The progress is reported in the dialogue box. To repeat the process click Retry. 

 

6. Once the process is completed click OK to return to the SMS Management dialogue box. If 963 detects the 

GSM modem its details will be used. If the GSM modem was not correctly detected you can configure the 

connection manually. 

7. If a PIN is required to access the SIM enter the required PIN in the SIM PIN box. 

Caution: If the PIN is incorrect all SMS activity will cease until a correct PIN has been entered and 

activated. Incorrect entry of a PIN number may result in the SIM being locked requiring a PUK 

number from the network service provider. It is recommended that any requirement for entry of a 

PIN to activate the SIM is disabled. 

8. If text messages are to include international (UCS-2) characters select the Send as international characters 

(USC-2) check box. 

Note that if international characters are used only 70 characters are allowed in the SMS message. If 

international characters are not used the message can be up to 140 characters. 

9. If text messages are to flash on the phone to select the Send as Flash SMS check box. 

10. If an alarm is to be generated after a certain number of alarms have been sent select the Use message limit 

alarm check box, and in the Message alarm limit box enter the number of alarms that are sent before the 

message alarm limit alarm is generated. 

This alarm is useful if a pay as you go SIM is being used to send the alarms. The message alarm limit can be 

set to the number of alarms that can be sent using the available credit on the SIM. 

11. Click Apply. 963 will attempt to communicate with the modem to determine the manufacturer ID, and status. 

If successful the information will be displayed in the dialogue box. The signal strength is also displayed in 

the Signal area. If unsuccessful 963 will inform you that it was unable to configure the GSM connection. 

Failure could be because the COM port may be in use by another program. The manufacturer ID and status 

can be re detected by clicking Redect info. 

12. Click OK. 
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2.9.2 Configure the GSM Connection Manually  

The GSM connection can be configured manually if for example the automatic configuration fails, or selects the wrong 

device if there is more than one. 

To configure the GSM connection manually: 

1. Run 963 and log in as someone with authority to configure SMS settings. 

2. If the SMS Management dialogue box is not displayed on the SMS menu click Properties to display it. 

 

3. In the COM port box click the COM port connecting the PC to the GSM modem. 

4. In the Baud rate box click the baud rate for communications between the modem and PC. 

5. If a PIN is required to access the SIM enter the required PIN in the SIM PIN box. 

Caution: If the PIN is incorrect all SMS activity will cease until a correct PIN has been entered and 

activated. Incorrect entry of a PIN number may result in the SIM being locked requiring a PUK 

number from the network service provider. It is recommended that any requirement for entry of a 

PIN to activate the SIM is disabled. 

6. If text messages are to include international (UCS-2) characters select the Send as international characters 

(USC-2) check box. 

Note that if international characters are used only 70 characters are allowed in the SMS message. If 

international characters are not used the message can be up to 140 characters. 

7. If text messages are to flash on the phone to select the Send as Flash SMS check box. 

8. If an alarm is to be generated after a certain number of alarms have been sent select the Use message limit 

alarm check box, and in the Message alarm limit box enter the number of alarms that are sent before the 

message alarm limit alarm is generated. 

This alarm is useful if a pay as you go SIM is being used to send the alarms. The message alarm limit can be 

set to the number of alarms that can be sent using the available credit on the SIM. 

9. Click Apply. 963 will attempt to communicate with the modem to determine the manufacturer ID, and status. 

If successful the information will be displayed in the dialogue box. The signal strength is also displayed in 

the Signal area. If required the manufacturer ID, and status can be re detected by clicking Redect info. 

10. Click OK. 
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2.10 Connect to the IQ Network 

963 can be connected to the IQ network over Ethernet using a standard Ethernet connection; this allows the office IT 

network to be used to connect 963 to the IQ network. Connecting 963 in this way requires a virtual CNC operating in 

supervisor mode. The device containing the vCNC should be selected according to the type of access that is required. 

 Casual access to point data for general browsing of the system can be carried out through any vCNC. 

 Time critical, or densely populated displays of data (such as Schematic pages on fast refresh rates, or with 

more than 20 points per page) are recommended to be used on vCNC’s in either a XTEND or IQ4 controller 

with no significant control strategy in them (e.g. an IQ4 placed in the system solely as a vCNC access point). 

 Where the highest level of performance is required and/or multiple vCNC connections are required then a 

XTEND should be used. 

To connect 963 to the IQ network over Ethernet: 

1. Ensure the PC is connected to the Ethernet network. 

2. Run 963. 

3. Log in as someone who can display the Communications Window. 

4. Press F1 to display the Information Centre. 

5. Click . The Communications Window will be displayed. 

6. Click Configure Comms. The Local Site Connection Setup dialogue box is displayed. 

 

7. Click TCP/IP. 

8. In the IP Address or hostname box enter the IP address or hostname of the device containing the virtual 

CNC to which 963 is to connect. The hostname must be entered in quotes e.g. "Boilers". 

Note that a hostname should be used if a DHCP server is being used on the system to setup the IP settings of 

the device containing the virtual CNC. You should also remember that 3xtend/EINC L's, and IQ3 controllers 

earlier than v1.3 do not support hostname addressing. 

9. In the Port Scan From box enter the port number of the first vCNC in the range of vCNCs to which 963 can 

connect (e.g. 10005). 

10. In the Port Scan To box enter the port number of the last vCNC in the range of vCNCs to which 963 can 

connect (e.g. 10006). 

11. In the Site GUID box enter the machine-readable site code for the site. The machine-readable site code must 

be enclosed in curly brackets ({}) 

963 will be able to connect to the IQ network using any of the ports in the specified range. Because each port 

has a specific address on the IQ network, the address of 963 on the IQ network will vary depending on which 

port it uses. 

If alarms are to be sent to 963 through this device, the top and bottom of the range must be the same 

to ensure the same network address is used each time 963 is started. 

11. If 963 is to only access remote TCP/IP sites select the Click here if you have no local site communications 

check box. 

12. Click OK. 

13. Restart 963. 

Note that if the device containing the virtual CNC goes into link/local mode (e.g. DHCP server fails) the 963s 

connection to the IQ network will be lost. This is expected behaviour if the PC is on the same network segment as the 

device containing the virtual CNC restart the PC. If the device is on a different subnet it will be necessary to fix the 

problem that caused the device to go into link/local mode. 

2.10.1 Connect over the Current Loop  

963 can be connected the IQ network over the IQ current loop using a NBOX/CNC2, which must be purchased 

separately. 
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To connect to the IQ network over the current loop: 

1. Ensure the 963 is not running. 

2. Install the NBOX/CNC2 as described in the supplied installation instructions and connect it to the PC running 

963. 

3. Run 963. It will automatically detect the communications speed between its serial port and the NBOX/CNC2 

used for this communication. 

If this automatic detection fails the communications settings can be configured manually. 

To configure the communications setting manually: 

1. Log in as someone who can display the Communications Window. 

2. Press F1 to display the Information Centre. 

3. Click . The Communications Window will be displayed. 

4. Click Configure Comms. The Local Site Connection Setup dialogue box is displayed. 

 

5. Click Specific COM Port and enter the required COM port number. Clicking Auto Scan Com Port will 

cause 963 to find the port that is connected to the NBOX/CNC2 automatically which is the default, and 

should only be changed if there are communication problems. 

6. Click OK. 

7. Restart 963. 

2.11 Check Communications  

Once 963 is connected to the IQ network it is advisable to check that the communications are working correctly by 

looking at the Basic Communications Display, shown below. The display appears at the bottom of 963’s window. It 

provides information about the status of communications in and out of the node connecting 963 to the IQ network, 

and the status of any remote connection devices on the system. 

 

TX and RX indicators: These flash green when 963 receives, or transmits information. If they appear grey, the 

963 has been unable to locate the CNC. 

Remote connection indicator: If grey, all of the devices are available for use, if red, at least one of them is 

attempting to make a connection, and if green, at least one is connected. Clicking this icon displays the Remote 

Connection Window. 

2.12 Configure the Windows User to have Access to SQL Server  

The Windows users that are to run 963 must have access to SQL Server. If the user is an 'Administrator' user (is a 

member of the 'Administrator' workgroup) it will have access to SQL Server and no additional configuration is 

necessary. However if the user is not is a member of the 'Administrator' workgroup it is necessary to give the user 

access to SQL Server. This can be done by either making the user a power user (in the 'Power Users' Windows 

workgroup) and setting 963 to connect to SQL Server in SQL Server Authentication mode, or giving the user access 

to SQL Server, and connecting to SQL Server in Windows authentication mode, this is the more secure option, but 

requires more configuration. 

To make the user a power user and set 963 to connect to SQL server in SQL Server Authentication mode: 

1. Log in to the PC as someone with Administrator rights. 

2. Add the user to the 'Power Users' Windows workgroup. For details about configuring Windows user accounts 

and workgroups see appropriate operating systems documentation. 

3. Run 963. 

4. Log in as some with System Administrator rights. 
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5. On the Database menu click Properties. The Database Properties dialogue box is displayed. 

 

6. Select the Using SQL Server Authentication check box in the Connect to SQL Server area. 

7. Click OK. 

8. Close 963. 

To give the user access to SQL Server and set 963 to connect to SQL server in Windows Authentication mode: 

1. Log in to the PC as someone with Administrator rights. 

2. Give the user access to SQL Server by adding the user to the ‘SQLSERVER2005MSSQLUSERS$<xxxx>’ 

Windows workgroup. Where <xxxx> is the PC name. This group is created when SQL Server is installed. 

See the SQL Server documentation for details. For details about configuring Windows user accounts and 

workgroups see appropriate operating systems documentation. 

3. By default 963 connects to SQL Server in Windows Authentication mode. To check this is the case ensure 

that the Using SQL Server Authentication check box in the Connect to SQL Server area of the Database 

Properties dialogue box is cleared. 

2.13 Install a Language Version not available in the Installation Program  

Some language variants cannot be installed using the 963 installation program. These languages can be installed 

following the procedure below: 

Install a language version not available in the installation program: 

1. Install 963. 

2. Ensure that 963 is not running. 

3. Copy the following files for the required language from the appropriate directory on the 963 DVD into the 

963 install directory (normally c:\program files (x86)\trend control systems\963). There is a directory for 

each language that can be installed in this way in the Support Files\Translations directory of the 963 DVD. 

 S2RES.DLL 

 Tcomsrv.dll 

 ToolkitPro.Resource*.dll 

4. Copy the following javascript files for the required language from the appropriate directory on the 963 DVD 

into the 963 install javascript directory (normally c:\program files (x86)\trend control 

systems\963\HTML\js).There is a directory for each language that can be installed in this way in the Support 

Files\Translations directory of the 963 DVD. 

 StringResource.js 

 jquery.ui.datepicker-settings.js 
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2.14 Support for Virtualisation and Operation as a Service 

963 can be installed along with 3rd party software to provide a fault tolerant high availability solution using, both a 

'Service Wrapper' & 'Virtualisation'. 

Operation as a Service 

963 cannot run as a native service however 963 v3.73 [SP2] has been tested to operate using a service wrapper 

(AlwaysUp v8.5). 

The service wrapper wraps up the application within a service environment monitoring it constantly to ensure 100% 

uptime. It will automatically start the 963 application when the PC starts and in the event of a failure ensuring 24/7 

availability of the software. 

Operation in a Virtual Environment 

963 v3.73 [SP2] has been tested to operate in a virtual environment (virtualisation) which can used to either reduce 

hardware requirements (server consolidation) or provide a high availability / fault tolerant system. 

Virtualization is supported using the virtual environment software VMware vSphere v5.1. This software uses the 

concept of clustered servers/ server consolidation ensuring that the virtual environment is switched across to an 

alternative server in case of a hardware failure. 

Important: Running 963 as a service or in a virtual environment requires additional 3rd party software. Please consult 

an IT specialist with expertise in these types of solution to ensure the system is correctly configured. 
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3 UPGRADE 963 

In most situations upgrading form an earlier version of 963 will simply be a matter of inserting the 963 DVD and 

following the instructions on the screen. The existing version of 963 will be upgraded to the latest version, and the 

963's database updated accordingly. There should be no need to re-licence 963. 

Note that there was an error in earlier installations of 963 which meant that the clicking the ? on a schematic page 

did not run the user guide. This has been corrected for new installs of 963 in v3.40. However in order to preserve any 

schematic pages that have been created the upgrade does not overwrite the existing schematic pages. The issue can 

be corrected by performing a find and replace on the schematic pages to find 'WINEXEC winhlp32.exe 

<DATA>\documentation\963 user guide.hlp' and replace it with 'WINEXEC hh.exe <DATA>\documentation\963-

User-Guide.chm'. 

In the following circumstances it will be necessary to follow a different installation procedure. 

 Upgrading a 963 where the 963's database is running on a remote SQL Server (i.e. on another PC). 

 Upgrading from 963 v1.x or 962 it may be necessary to check the SQL queries.. 

3.1 Upgrade 963 when the Database is on a Remote PC  

If upgrading a 963 where the 963's database is running on a remote SQL server (i.e. on another PC) the installation 

program will not be able to perform the necessary updates to the 963's database on the remote PC therefore it will be 

necessary to manually upgrade the 963 database on the remote PC. 

To upgrade 963 when the database is on a remote PC: 

1. If necessary upgrade the SQL Server to one of the supported versions. 

963 supports the following versions of SQL Server: 

 SQL Server 2012 or 2017 

2. Run 963. 

3. Log in to the PC as someone with Administrator workgroup. 

4. On the Database menu click Properties. The Database Properties dialogue box is displayed. 

 

5. Select the Detach database after supervisor has been shutdown check box. 

6. Click OK. 

7. Close 963. 

8. Backup the database files, and any other data files before upgrading 963. 

9. Upgrade the 963 on the 963 PC ensuring that the 963 is installed in the same directory as original 963. 

10. Do not run 963. 

11. Copy the 963 database files (mdf and ldf files in the C:\program files (x86)\trend control 

systems\963\database directory) from the remote PC to the same location on the 963 PC. 

12. Run notepad, and open the S2.INI file in the install directory (normally c:\program files (x86)\trend control 

systems\963). 

Note that run notepad must be run with administrator rights. This will require you to have access to a 

password for a Windows user with administrator rights. 

13. Search through the file to find the following line: 

[DATABASE] 

Server= 

14. Make a note of the 'Server=' setting you will need it later. 
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15. Change the 'Server=' setting to '.' so 963 uses the local database files as shown below. 

Server=. 

16. Run 963. The local database files will be updated. 

17. Close 963. 

18. Copy the 963 database files (mdf and ldf files in the C:\program files (x86)\trend control 

systems\963\database directory) from the 963 PC to the same location on the remote PC. 

19. Set the 'Server=' setting in the [DATABASE] section of S2.INI file back to the original setting before it was 

changed in step (15). 

20. Run 963. 

3.2 Upgrade from 963 v1.x or 962 

If 963 v1.x or 962 has been installed and engineered on the PC, it is possible to upgrade to the latest version of 963 

without having to re-engineer the system. However a new licence is required to enable 963 to run if upgrading from 

962. The upgrade process will make a backup of the previous system so that if you decide not to purchase 963 it is 

possible to return to the original system. 

Note that historic alarms are not imported from the old 963 database. However they can still be viewed by viewing 

historic records, and specifying the old database. Schematic pages in version 2 are not backwards compatible with 

version 1. Therefore if pages are required to run in both version 1 and version 2 they must be engineered with 963 

v1. 

To upgrade from 963 v1.x or 962: 

1. Backup the database files, and any other data files before upgrading 963. 

2. If installing 963 on a PC that has a full installation of SQL server upgrade the SQL Server to one of the 

supported versions. 

963 supports the following versions of SQL Server: 

 SQL Server 2012 or 2017 

3. If SQL Server has been prevented from performing command execution this must be re-enabled, see the 

'Restrict SQL Servers Ability to Perform Command Execution' section of the 963 Engineering Manual 

(TE200637). 

4. Close 963 or 962. 

5. Install 963 ensuring that the 963 is installed in the same directory as original 963 or 962. 

6. If the old configuration uses the VIEWQUERY, QUERYTOTEXTFILE, or PRINTQUERY actions it is 

recommended that you check the SQL queries to ensure that they work correctly and if necessary fix the 

problem. 

7. Alarm actions configured for a specific point are no longer supported a suitable alarm filter and alarm group 

should be configured instead. 
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3.2.1 Check SQL Queries 

If upgrading from a version of 963 earlier than v2.1 that uses the VIEWQUERY, QUERYTOTEXTFILE, or 

PRINTQUERY actions it is recommended that you locate the places they are use and ensure that they work correctly 

and if necessary fix the problem. This is because the database format used by v2.1 is different from earlier versions 

of 963 and therefore these actions may now fail. Theses action can be used on schematic pages, alarms actions, and 

in scheduled events. Some tools have been provided help you locate the places these actions are being used. Once you 

locate where these actions are used you should check each one in turn to ensure that it works correctly, and if not 

modify the SQL. For details of the 963’s database structure see the ‘Databases’ section of the 963 Engineering Manual 

(TE200637). 

To check the SQL queries: 

1. Run 963 and log in as a user who can access Tool menu. 

2. On the Tools menu point to Search SQL From and then click Schematics, Scheduler, or Alarms depending 

on which area of the 963 is to be searched. It may be necessary to search all three areas. 

If Schematics was selected the Find SQL on Schematic dialogue box is displayed. 

 

 In the Select action to find box select the action that you want to search for. To search for all three actions 

select All. 

 In the Search Options area select the schematic pages that are to be searched. Click Search current 

schematic/folder to search the folder selected in the Navigator, or Search all schematics to search all 

schematics. 

 To create a log file of the search results select the Generate log file check box. 

 To prevent the search results being displayed in the Results box clear the View Results check box. 

 Click Find. The search will be carried out. If the View Results check box is selected the results will be 

displayed in the Results box. To goto to a schematic page that has matched the search click it in the Results 

box and click GOTO Selected Page. 

If Scheduler was selected a dialogue box listing any scheduled events that use the VIEWQUERY, 

QUERYTOTEXTFILE, or PRINTQUERY actions. 

If Alarms was selected a dialogue box listing any alarm actions that use the VIEWQUERY, 

QUERYTOTEXTFILE, or PRINTQUERY actions. 
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3.2.2 Return to the Original 963 System 

When you upgrade from an earlier version of 963, or 962 a backup of the system is made in a subdirectory of the 

install directory called 963_backup, or 962_backup. This means that if you decide not to use the latest version of 963 

it is possible to return to the original system. 

To return to the original system: 

1. Copy the entire contents of the backup directory Backups into the install directory, normally c:\program 

files (x86)\trend control systems\963 or c:\program files\trend control systems\962. 

3.3 Transfer the Licence to a Different Location 

If you want to use your 963 licence to run 963 in a different location e.g. on a different PC, or in a different directory, 

it is necessary to transfer the licence to that location. 

To transfer the licence: 

1. Install 963 in the new location. 

2. Run 963 in the new location. 

3. Log in as someone with a PIN level of 99. 

4. Press F1 to display the Information Centre. 

5. Click . The Licence Editor dialogue box is displayed. 

 

6. If transferring the licence to a different PC connect the removable media that is to be used to transfer the 

licence. 

Note that this has been tested on floppy disk, USB flash disk. Trend cannot guarantee that other removable 

media type will work. 

7. Click Register transfer. The Browse for Folder dialogue box is displayed. 
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8. Click the location to which the licence is to be copied. If moving the licence to a different PC this is the 

removable media. To create a new folder click Make New Folder. 

9. Click OK. The Are you sure? dialogue box is displayed. 

10. Click OK. 

11. If transferring the licence to a different PC remove the removable media. 

12. Run 963 the currently licensed 963. 

13. Log on as someone with a PIN level of 99. 

14. Press F1 to display the Information Centre. 

15. Click . The Licence Editor dialogue box is displayed. 

16. If transferring the licence to a different PC connect the removable media being used to transfer the licence. 

17. Click Transfer Out. The Browse for Folder dialogue box is displayed. 

18. Click the location specified in (8). 

19. Click OK. The Are you sure? dialogue box is displayed. 

20. Click OK. The licence will be moved to the specified location. The 963 is no longer licensed to run in that 

location. 

21. Run 963 in the new location. 

22. Log on as someone with a PIN level of 99. 

23. Press F1 to display the Information Centre. 

24. Click . The Licence Editor dialogue box is displayed. 

25. If transferring the licence to a different PC connect the removable media being used to transfer the licence. 

26. Click Transfer In. The Browse for Folder dialogue box is displayed. 

Note that if Transfer In is not available, it is necessary to delete the ‘s2.key’ in the install directory. 

27. Click the location where the licence has been stored in (8). Click OK. The Are you sure? dialogue box is 

displayed. 

28. Click OK. The licence will be moved to the new location. The 963 is now licensed to run in the new location. 

29. Click Close.  
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4 HTTPS WEB SERVER SETTINGS 

963 now operates on a secure protocol, SSL (https). This means a certificate must be provided to ensure that the web 

server connection is secure. This certificate can either be purchased online or a self signed certificate can be generated. 

963 provides a utility to create a self signed certificate as well. 

Refer to the Engineering Manual (TE200637) for a detailed procedure on how to import, export, and generate a self 

signed certificate.  
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5 STARTUP DIAGNOSTICS 

Start-up diagnostics provide additional help when 963 fails to connect to the database. It identifies the following and 

enables the user to correct the details: 

 Back-end SQL service cannot be found 

 Server PC cannot be found 

 Database cannot be found 

5.1 Back-end SQL service cannot be found 

When 963 is started it looks to see if the SQL service is running (default is MSSQLSERVER). If the specified SQL 

service is not running a dialogue box is displayed that indicates the name of the SQL service required by 963 and 

allows the name of the service to be corrected if it is wrong. Clicking Cancel will close down 963. 

The name of the SQL service is specified in the [DATABASE] section of S2.INI: 

[Database] 

Service=MSSQLSERVER 

Possible causes: 

 Incorrect name entered 

 Multiple installations of SQL Server running on the same PC with different names 

5.2 Server PC cannot be found 

When 963 is started it looks for the PC hosting the database. If the database cannot be found a dialogue box is displayed 

that indicates the location of the PC to be corrected if it is wrong. Clicking Cancel will close down 963. 

The name of the PC is specified by server name and the default is the name of the local PC. It is specified in the 

[DATABASE] section of S2.INI: 

[Database] 

Server=use local computer name 

Possible causes: 

 Non-standard installation gone wrong 

 963 database hosted on a separate SQL Server PC that cannot be found 

Note: This an be slow to detect as it involves network requests. 

5.3 Database cannot be found 

When 963 is started it looks for the database on the hosting PC (default isi96x). If the database cannot be found a 

dialogue box is displayed that indicates the name of the database and allows the name to be corrected if it is wrong. 

Clicking Cancel will close down 963. 

The name of the SQL service is specified in the [DATABASE] section of S2.INI: 

[Database] 

DBNAME=i96x 

Possible causes: 

 Non-standard installation gone wrong 

 963 database hosted on a separate SQL Server PC that cannot be found 

 



Startup Diagnostics 

963 Installation Instructions TG201026 Issue 15, 29-Jan-2019 44 

Index 
Basic Communication Display 34 

Check 

Communications 34 

Check SQL Queries 39 
Communications 

Check 34 

Connect 33 
Port 33 

Configure 

GSM Connection 30, 32 
Configure the Windows user account 34 

Connect 
Ethernet Network 9 

GSM Modem 30 

IQ Network 33 
Contacting Trend 5 

Conventions Used in this Manual 5 

Database 
Remote 28 

Ethernet Network 9 

GSM Connection 
Configure 30, 32 

Signal Strength 30, 32 

GSM Modem 
Connect 30 

Install 

963 7, 35 

Software 9 

IQ Current Loop 33 

IQ Network 33 
Licence 

963 26 

Obtain Unlock Code 25 
Transfer 40 

Remote 

Database 28 
SQL Server 28 

Return to the Original 963 System 40 
Set up 

GSM Connection 30, 32 

Software Installation 9 
SQL Queries 

Check 39 

SQL Server 
Remote 28 

Transfer the Licence 40 

Trend Network 33 
Unlock Code 

Enter 26 

Obtain 25 
Upgrade 

From 963 v1 40 

 



Startup Diagnostics 

 

 

 



 

 

Trend Control Systems Limited 

St. Marks Court, North Street, Horsham, West Sussex, RH12 1BW, UK. Tel:+44 (0)1403 211888, www.trendcontrols.com 

 


